Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tips &amp; Tricks – Allegro PCB Editor</td>
<td>4</td>
</tr>
<tr>
<td>Reducing Mouse Clicks &amp; Travel</td>
<td>4</td>
</tr>
<tr>
<td>Snap a Rat T to a Pin/Via</td>
<td>6</td>
</tr>
<tr>
<td>Alias commands to the Middle Mouse Wheel</td>
<td>7</td>
</tr>
<tr>
<td>Replacing Padstacks by window selection</td>
<td>7</td>
</tr>
<tr>
<td>Changing Net Names on Vias</td>
<td>7</td>
</tr>
<tr>
<td>Polygon selection window</td>
<td>7</td>
</tr>
<tr>
<td>Z-Copy – a powerful utility</td>
<td>7</td>
</tr>
<tr>
<td>Fix/Unfix Elements in the Design</td>
<td>8</td>
</tr>
<tr>
<td>Datatip Options</td>
<td>10</td>
</tr>
<tr>
<td>Status Form traffic lights</td>
<td>11</td>
</tr>
<tr>
<td>“Go to” X,Y Location</td>
<td>11</td>
</tr>
<tr>
<td>Disabling Custom Color Assignments</td>
<td>12</td>
</tr>
<tr>
<td>Color Dialog – Open last folder used</td>
<td>12</td>
</tr>
<tr>
<td>Display a Layer</td>
<td>13</td>
</tr>
<tr>
<td>Invoking Allegro in No OpenGL mode</td>
<td>13</td>
</tr>
<tr>
<td>Display of Properties in the Canvas</td>
<td>14</td>
</tr>
<tr>
<td>Suppress Pin–Pin Violations within the same symbol</td>
<td>15</td>
</tr>
<tr>
<td>Creating a Command Shortcut with Scriptmode +e</td>
<td>16</td>
</tr>
<tr>
<td>Scriptmode +i</td>
<td>17</td>
</tr>
<tr>
<td>DFA Dynamics – Controlling spacing bubble resistance</td>
<td>17</td>
</tr>
<tr>
<td>“Locked” property</td>
<td>17</td>
</tr>
<tr>
<td>Shape has “No Etch” Status – find it</td>
<td>17</td>
</tr>
<tr>
<td>Voiding of GND clines through GND Plane</td>
<td>18</td>
</tr>
<tr>
<td>How to convert non acute angles for shapes to round corners?</td>
<td>18</td>
</tr>
<tr>
<td>HTML Reports</td>
<td>18</td>
</tr>
<tr>
<td>Control P “Print form”</td>
<td>19</td>
</tr>
<tr>
<td>Adding Text (from a file)</td>
<td>20</td>
</tr>
<tr>
<td>Method to renumber all ref des from a starting number</td>
<td>20</td>
</tr>
<tr>
<td>Why does the system react slowly when moving a comp?</td>
<td>20</td>
</tr>
<tr>
<td>Why does DRC Update take hours to run?</td>
<td>21</td>
</tr>
<tr>
<td>Is my Database Optimized for Performance?</td>
<td>21</td>
</tr>
<tr>
<td>Read Only Variables</td>
<td>21</td>
</tr>
<tr>
<td>BBVIA GAP DRC reporting too many DRCs</td>
<td>23</td>
</tr>
<tr>
<td>Same Net DRCs not being generated?</td>
<td>24</td>
</tr>
<tr>
<td>Working with Xnets</td>
<td>24</td>
</tr>
<tr>
<td>Diff Pair Gathering</td>
<td>25</td>
</tr>
<tr>
<td>Route a Tandem Diff Pair</td>
<td>26</td>
</tr>
<tr>
<td>Display Length Meter for non constrained nets</td>
<td>26</td>
</tr>
<tr>
<td>Constraint Manager</td>
<td>27</td>
</tr>
<tr>
<td>Constraint Resolution</td>
<td>29</td>
</tr>
<tr>
<td>Assign pins of dummy nets to Net Classes</td>
<td>30</td>
</tr>
<tr>
<td>Preventing Shorts</td>
<td>30</td>
</tr>
<tr>
<td>Suppress SIGNOISE Warnings and Error messages</td>
<td>31</td>
</tr>
<tr>
<td>Write vs Save</td>
<td>31</td>
</tr>
<tr>
<td>Autosave the Database</td>
<td>31</td>
</tr>
<tr>
<td>Reopen command</td>
<td>32</td>
</tr>
</tbody>
</table>
Tips & Tricks – Allegro PCB Editor

File Management (artwork, plots, log files, reports) ......................................................... 32
Open File Manager from Allegro .......................................................................................... 32
Looking for a particular pad stack based on holesize? ......................................................... 32
Testability – Multiple Probe-Type Support ........................................................................ 33
Drill Legend Support for INCHES and METRIC ............................................................... 33
Uprev Symbols .................................................................................................................. 34
Troubleshooting – Running Allegro in Safe Mode ............................................................... 35
Tips from Allegro PCB Users............................................................................................ 35
Windows 7 – Graphic issues.............................................................................................. 36
Allegro Tips and Tricks - SPB 16.3

This document provides Tips and Tricks recommended by Ed Hickey of Cadence.

Reducing Mouse Clicks & Travel
Tips to help reduce the number of mouse clicks & travel to the options panel.

Adding Vias – Use of Space Bar
Adding a via has traditionally been done with a double click of the LMB. The use of the space bar can save you 1000’s of mouse clicks per year. I suggest adding the function key below to your local env file. The spacebar entry is represented by “ “. Other keys can be assigned but space bar is easy to click without looking down.

funckey " " "pop bbdrill -cursor"

Adding Vias – “Working Layer” model
The Working Layer “WL” model to add vias is now available (16.3) in all backend products. It can be used to add conventional through-hole or staggered/stacked HDI vias. Select your target routing layer from a popup GUI that appears adjacent to the via insertion area.

- Order the vias in each Physical Cset
- Click on the “…” to access alternative (least preferred) vias

Add Connect – Single click execution
Tips & Tricks – Allegro PCB Editor

In Etch Edit Application Mode, make a single pick on a pin, via or rat to begin Add Connect. Ensure “Enable Single Pick Execution” mode is enabled. Access this option from the RMB – Customize menu.

Add Connect – Add a vertex using a Funckey key

Instead of using the LMB to add a vertex point during Add Connect, consider using a Function Key. Simply click the X key every time you want to add a vertex during routing.

   funckey x "pick_to_grid -cursor"

Add Connect – Toggle between line-types of line and arc during route

   alias a1 'FORM mini lock_mode Arc;FORM mini lock_direction 45'
   alias a2 'FORM mini lock_mode Arc;FORM mini lock_direction 90'
   alias a3 'FORM mini lock_mode Line;FORM mini lock_direction 45'
   alias a4 'FORM mini lock_mode Line;FORM mini lock_direction 90'
   alias F2 'settoggle CMD a1 a2 a3 a4;SCMD'

Slide – Single Click Execution

In Etch Edit Application Mode, make a single pick on a cline segment to slide it.

Change Active/Alternate Layers using Function Keys

Increment or decrement the active or alternate layer

   funckey + subclass ++ (use of “+” character to increment active subclass)
   funckey - subclass -- (use of “-” character to decrement active subclass)
   funckey a altsubclass ++ (use of “a” character to increment alternate subclass)

Directly change the active layer

   funckey 1 options subclass TOP
   funckey 2 options subclass SIGNAL_2
   funckey 3 options subclass SIGNAL_3
   funckey 4 options subclass SIGNAL_4
   funckey 5 options subclass SIGNAL_5
   funckey 6 options subclass SIGNAL_6
   funckey 7 options subclass SIGNAL_7
   funckey 8 options subclass BOTTOM

Another method to change the active subclass is from the RMB:

   RMB – Quick Utilities – Change Active Subclass

Deleting Elements using a Function Key

**Tips & Tricks – Allegro PCB Editor**

I think I use this function key more than any other one. Just pass your cursor over a cline, segment, via, text or shape and click “d” to delete it. No click of the mouse!

```
funckey d "prepopup; pop dyn_option_select @:@Delete"
```

**Moving Components – Single click execution**

In Placement Application Mode, make a single LMB pick on a component to move it.

**Rotating a Component using a Function key**

Press the function key R to rotate a component during movement

```
funckey r iangle 90
```

**Mirror a Component using a Funckey Key**

Press the function key M to mirror a component during movement

```
funckey m "pop mirror"
```

**Snapping using a Funckey Key**

While moving an object, use a function key to snap to various elements.

```
funckey f "prepopup;pop dyn_option_select 'Snap pick to@:@Figure"
funckey i "prepopup;pop dyn_option_select 'Snap pick to@:@Intersection"
funckey c "prepopup;pop dyn_option_select 'Snap pick to@:@Arc/Circle Center"
funckey v "prepopup;pop dyn_option_select 'Snap pick to@:@Via"
```

**Snap a Rat T to a Pin/Via**

While moving a Rat T, try setting rotation point to “Body Center”
Alias commands to the Middle Mouse Wheel

The “button” command can be used to alias the Middle Mouse Wheel to commands; works with SHIFT, CONTROL and SHIFT-CONTROL combinations.

Examples:

button Swheel_up subclass -+
button Swheel_down altsubclass -+
button Cwheel_up "roam y -$roamInc"
button Cwheel_down "roam y $roamInc"
button SCwheel_up "roam x -$roamInc"
button SCwheel_down "roam x $roamInc"

In Constraint Manager, those of us with “older eyes” can use the <Control> Middle Mouse Wheel to increase the font size.

Replacing Padstacks by window selection

In General Edit Application Mode, window around the set of pins or vias you wish to change then use the RMB – Symbol Pin or Via – Replace Padstack – Selected Instances command.

Changing Net Names on Vias

A skill application called “change_net_on_vias.il” is located in your install directory - /share/pcb/examples/skill/cmds

Polygon selection window

If a polygon selection window is desired;

RMB – Selection Set – Select by Polygon

Z-Copy – a powerful utility

This is a basic function that everyone should know.

Create a Route Keepin area derived from the board outline
Tips & Tricks – Allegro PCB Editor

Select Edit Z-COPY, adjust the options settings to class = ROUTE KEEPIN, Subclass = ALL. Enable 'contract' then enter value the route keepin will be offset from the board outline. Last step is to select the board outline.

Did you know Z-Copy can be used to copy to multiple layers at once?

For example you wish to create multiple GND planes but the names of each subclass end in GND_5, GND_8, GND_13, etc. Use Z-Copy then in the options tab select one of the GND layers. Edit the numerical part of the layer then enter the wildcard '*' as shown in the graphic below.

Fix/Unfix Elements in the Design

Tips to add and remove the Fixed Property

Quickly unfix all elements
Tips & Tricks – Allegro PCB Editor

The quickest method to remove the fixed property from all elements in the Design is to:

1. Click the Unfix Icon

2. Then RMB – Unfix All

Fix a Symbol’s location

Simply mouse over the symbol then select the “Fix” command from the context sensitive RMB menu.

Datatip display of the Fixed property

You would like to know whether an element is fixed while hovering over it.
Tips & Tricks – Allegro PCB Editor

Configure the datatip setting as shown below. You may want to enable other symbol related properties to also display in the datatip window. This is done from the Setup – Datatip Customization menu. Select symbol Instance under Object Type then enable the value “FIXED”.

Datatip Options

Controls for delay, location and disablement

The User Preference Editor contains hundreds of variables. The “Search” box is a very handy mechanism. In this example, I type in the word “datatip” then click Search. Variables to delay, locate and disable datatips are available to you.

The complete set of variables related to Datatips is located in the Display-Datatips Category
Status Form traffic lights
Did you know you can click on the indicators to obtain a report?

“Go to” X,Y Location
**Tips & Tricks – Allegro PCB Editor**

*Navigate to an X, Y location in the Design*

You wish to quickly go to a specific X, Y location in the Design; for example go to location \( x = 5000, y = 7000 \).

Adjust your zoom level then make a click on the ‘P’ button located at the base of the canvas display. Enter in your coordinates then click “Pick”

**Note – Please set application mode = none for this behavior**

![Zoom Center](image)

**Disabling Custom Color Assignments**

You may inherit a board from another designer or shop and question some of the color assignments. One quick method to disable color overrides that may have been applied to nets, buses, Diff Pairs is to go into the color form. If you select the “Nets” radio button on top, you will see a new button called “Disable Custom Colors.” Select that option to revert to “layer” based coloring.

![Color Dialog](image)

**Color Dialog – Open last folder used**

Set the variable “color_lastgroup” located in user preference - UI - control_panel
Display a Layer

Click the color swatch box to the left of the subclass to quickly turn layers on/off during a command.

Invoking Allegro in No OpenGL mode

It may be necessary to run Allegro in No OpenGL mode; for example, hosting a Net Meeting. Consider creating a Desktop Shortcut for Allegro.exe with the –noopengl option.
Display of Properties in the Canvas

Any property attached to an element can be displayed in the canvas. From the Display – Property menu, select the Graphics tab then select properties to display from the left column. Clicking the Create button writes out the property values and/or their name to the subclass properties.
Suppress Pin-Pin Violations within the same symbol

PCB Designers often use Constraint Regions to suppress pin to pin violations within the same symbol. The property “nodrc_same_sym_pin” can be applied to the symbol but did you know it can also be applied to the drawing? Applying it at the drawing level has a global impact to all symbols.

1. Edit – Property – then select drawing in the Find by Name field.

2. Select Drawing Select, it’s now moved to the selected objects column

3. Click Apply then pick the nodrc_same_sym_pin from the list
Creating a Command Shortcut with Scriptmode +e

Adding a drawing level property in the previous tip was labor intensive. Let’s create a shortcut.

1. Enter scriptmode +e in the command window. This echoes the commands you enter.

2. Copy all the commands above to a single line

3. Separate with semi-colons

4. Map to a function key. When using multiple commands in a function key or alias they must be surrounded by double quotes.

5. `funckey e "property edit;setwindow form.find;FORM find name_type Drawing;FORM find find_by_name;FORM findname objlist 'Drawing Select';FORM findname done"

6. Click the "e" key then press "ENTER" in the command window to launch the property editor dialog!!
Scriptmode +i

"scriptmode +i" is really a shorthand for "scriptmode +invisible"

Let’s say you want to create an alias for toggling end cap display but don’t want to see the parameter form appear while executing the script.

```plaintext
alias ec "scriptmode +i; prmed; FORM prmedit display_enhance toggle; FORM prmedit done"
```

DFA Dynamics – Controlling spacing bubble resistance

**Issue** - When placing components to DFA rules, it’s difficult to pull back the component when the bubble appears.

The resistance can be controlled by the "dfa_pause_level" variable located in user preference – DFA_DRC. Set to 0 for no resistance.

**“Locked” property**

The Locked property was designed for Re-Use modules but did you know ….

The property can be applied to a place replicate circuit to prevent accidental movement of its members.

It can also be applied to a package symbol to prevent editing/deletion of the assembly outline or other data elements.

Suggestion – consider applying the locked property to the symbol definition (at the library level).

Shape has “No Etch” Status – find it

A dynamic shape is "out of date" BUT has a "No Etch" status.

You cannot find the shape in question. It says it’s at a particular XY location, on a particular layer, but there is nothing there. Turn on the “Boundary” color item for that layer to locate the shape outline.
**Voiding of GND clines through GND Plane**

*A method to auto-void GND sense lines being routed through a GND plane.*

In the example below, a GND net is routed through a GND shape. The property 'void_same_net' was applied to the cline.

---

**How to convert non acute angles for shapes to round corners?**

This feature is available in 16.3. Go to the dynamic shapes parameter and set the Acute angle control to "Full Round". Static shapes get the same capability in a future ISR with the eap_static_newsmooth env variable.

---

**HTML Reports**

Reports and messages can be displayed in HTLM format when the variable ‘allegro_html’ is set. One advantage of using HTML is the ability to search through the report.
Control P “Print form”

Did you know Control P can be used to print a form?
For example, inside of the DFA Symbol classification window click Cntrl-P to open up the Print form window then hit the “To File” button to save the information to a text file.
Adding Text (from a file)

**Tip to add text from a .txt file on disk**

- Run the add text command: Add > Text
  - Set the desired text options on the Control Panel “Options” tab
  - Set the Active class to Board Geometry
  - Set the Subclass to Dimension (or any other subclass)
  - Set Marker Size:
  - Set Rotation:
  - Set Text Block:
  - Set Text Justification:

- Position the cursor/Left Mouse Button (LMB) at the location that you want the first line of text to start.

- Right Mouse Button (RMB) and choose: Read from File

Method to renumber all ref des from a starting number

Use the variable fst_ref_des. You must ensure that the refdes digits in the Sequential Renaming section of the UI allows for the number of digits in the fst_ref_des variable.

** Variable located in User Preference – Manufacturing - Silkscreen

Why does the system react slowly when moving a comp?
Most likely your large pin-count nets are scheduled Min Tree. Add a voltage property or RATSNEST_SCHEDULE = POWER_AND_GROUND to large pin-count nets like Vcc and GND.

**Why does DRC Update take hours to run?**

Usually the slower checking is a result of a large number of constraint areas and/or a large number of overlapping constraint areas. If that is not the case, then it may be the larger spacing values that you have to satisfy you high voltage requirements or simply fudge values entered as no-ops. Large spacing values result in more neighboring items being examined for each item being checked.

** Review your extra large spacing values. I have seen the value of 999 entered on many occasions. When reduced, DRC update went from 1 hour to 3 minutes.

**Is my Database Optimized for Performance?**

The performance advisor provides suggestions to increase database performance. The command can be run from Tools – Database Check – Performance Advisor

---

**Read Only Variables**

A method for a site administrator to make variables read only

Add a “readonly” entry under the respective variable. In the example below, I wish to prevent the end user from modifying PSMPATH. The command readonly psmpath is added just below the “set psmpath” variable.
Tips & Tricks – Allegro PCB Editor

unset datatips_delay
set psmopath = D:\work\customers\IBM\ D:\work\marketing\Training\16.2\symbols
readonly psmopath
set padpath = D:\work\marketing\ Training\16.2\symbols\ D:\work\customers\IBM\
unset allegro_etch_length_on
set icon onclick = all

To verify in Allegro, type readonly at the command line prompt. The window lists variables that are readonly.

![Read Only Variables Window](image)

When an attempt is made to change psmopath in the user preferences editor, the following warning will appear:
**BBVIA GAP DRC reporting too many DRCs**

Under normal circumstances, Buried/Blind vias separated by less than the minimum bbvia gap rule will generate a DRC no matter how many layers separate them. A drawing level property, BBVIA SEPARATION, suppresses the DRC if the vias are separated by the specified layer span value or more. In the example below, the property value of “2” suppresses the DRC on the left side.
**Tips & Tricks – Allegro PCB Editor**

**Same Net DRCs not being generated?**

Most likely your “DRC by-layer” setting is set to “False”

---

**Working with Xnets**

*Tips for working with Xnets*

**Create them** – Assign Espice models to the discrete devices from the Analyze – SI/EMI Sim - Model Assignment menu.

**Prevent them** on an Instance basis - Assign the property no_xnet_connection at the component level.

**Display them** – In CM, Go to Object – Filter and enable “net” to see the nets of the Xnet
Naming Convention – The Xnet name defaults to the Net name with the lowest alphanumeric character. In the above example, L is before S.

Change the Xnet Name – In CM, select the Xnet then use RMB – Rename

Diff Pair Gathering
Looking for tighter coupling at the gathering location?
Decrease the value of the “padentry_factor” variable located in ETCH category of the User Preference Editor.
Route a Tandem Diff Pair

Pre route each member as shown in the graphic below then use add connect to route as a tandem pair. This assumes a Diff Pair constraint object has been created.

Display Length Meter for non constrained nets

Set the variable “allegro_etch_length” located in user preference > etch category
Constraint Manager

A few tips related to Constraint Manager

You wish to display propagation delay analysis for unrouted nets in CM. Enable the “unrouted” modes in Analyze > Analysis Modes > Options Tab

Sort results from worst case to best case margin
Double Click Margin Column Header or RMB Sort

Display just the Failed Results
Click Object Header then RMB > Filter, enable failed only. Or simply click on this Icon

Display just nets that have constraints on them?
Click Object Header then RMB > Filter, enable constrained only. Or simply click on this Icon
Segregate sections of CM with divider lines, i.e. identify the transition between buses and matched groups.

In CM, View > Options > Enable ‘Object Type Dividers’ or simply click on this Icon

You wish to change a constraint, min line width for example, across a certain layer of all available PCSETS.

Consider working in the “By Layer” worksheet to change the Top layer constraint across all available Csets

Export to Excel

Constraint Manager can export to a native excel spreadsheet (Windows Only & you must have Excel installed)
Tips & Tricks – Allegro PCB Editor

In CM: Tools – Excel – Active Worksheet/Workbook

**Constraint Resolution**

You want to see how the constraint resolves between 2 objects?

Use Display - Constraint then window select the 2 elements to obtain spacing resolution; select single element for physical resolution.

In the example below, I window selected the 2 clines of a Diff Pair to obtain spacing resolution. The actual measured gap is supplied in the middle section of the report.

---

### Constraint Hierarchy

<table>
<thead>
<tr>
<th>Description</th>
<th>Element 1</th>
<th>Element 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>(645.50 3587.00)</td>
<td>(645.50 3535.00)</td>
</tr>
<tr>
<td>NetClass</td>
<td>DP_CLASS_PS</td>
<td>DP_CLASS_PS</td>
</tr>
<tr>
<td>Bus</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DiffPair</td>
<td>DP_DR</td>
<td>DP_DR</td>
</tr>
<tr>
<td>XNet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Net</td>
<td>DP_DR_P</td>
<td>DP_DR_N</td>
</tr>
<tr>
<td>PinPair</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NetClass:NetClass</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Region</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Air gap distance between elements = 6.00000 mils

### Resolved Spacing and Diffpair Constraints

<table>
<thead>
<tr>
<th>Resolved Level</th>
<th>Source Name</th>
<th>Constraint</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design</td>
<td>DEFAULT</td>
<td>Line to Line Spacing</td>
<td>4 MIL</td>
</tr>
<tr>
<td>DiffPair</td>
<td>DP_DR</td>
<td>Differential Pair Primary Gap</td>
<td>6 MIL</td>
</tr>
<tr>
<td>DiffPair</td>
<td>DP_DR</td>
<td>Differential Pair Neck Gap</td>
<td>3.9 MIL</td>
</tr>
<tr>
<td>DiffPair</td>
<td>DP_DR</td>
<td>Differential Pair Coupled Tolerance Plus</td>
<td>0.1 MIL</td>
</tr>
<tr>
<td>DiffPair</td>
<td>DP_DR</td>
<td>Differential Pair Coupled Tolerance Minus</td>
<td>0.1 MIL</td>
</tr>
<tr>
<td>DiffPair</td>
<td>DP_DR</td>
<td>DiffPair Minimum Gap</td>
<td>3.8 MIL</td>
</tr>
</tbody>
</table>
Assign pins of dummy nets to Net Classes

In 16.3 (June 2010 ISR), enter the command cns_dummy_net or type helpcmd to get the complete Allegro command set.

---

**Preventing Shorts**

*A few suggestions I have seen on the SIG forum over the years ....*

- In Allegro, It is possible to override a DRC with properties, make sure that the nets involved don’t have the “NO_DRC” property on a pin(s).
- Make sure there are no “waived DRCs” that are not valid.
- Make sure your DRC modes are enabled. Be especially careful with newly released DRCs (ex Microvia based) as they are disabled by default.
- Run DBDoctor to keep the design in sync and up to date.
- Make sure the plane layers in the cross section form agree with the artwork control form (negative or positive).
- Make sure the padstacks are designed properly; both Antipads and thermals.
Include the IPC-D-356 netlist in your Fab Package; insist the Fabricator does a netlist to Gerber compare.

Suppress SIGNOISE Warnings and Error messages

To suppress Signoise warning and error messages from appearing in the message window, set the variable,

set sigsuppress ERROR WARNING

Write vs Save

You want to save the current board file you are working on as a new name but want to keep the current file open using its current name. The “Save As” function will make the saved file the active file.

Enter “WRITE” in the command window followed by a design name.

Autosave the Database

Key variables to autosave the database
Tips & Tricks – Allegro PCB Editor

Reopen command

Most people do not know about this convenient command which does what it says, reopens a design file.

Enter “reopen” in the command window to reopen the same file.

File Management (artwork, plots, log files, reports)

Looking to manage your artwork, plots and reports more efficiently? There is a suite of variables beginning with ADS designed to create subdirectories for common data files.

Open File Manager from Allegro

Quick method to explore to your working directory

Tools – Utilities – File Manager

Looking for a particular pad stack based on holesize?

There are 2 methods to obtain a report of library padstacks:

1. Manufacturing > NC > Drill Customization > Library Drill Report
2. PadDesigner > Reports > Library Drill Report

Sort by column type by placing cursor in one of the cells then RMB – Sort by ....
Testability – Multiple Probe-Type Support

The Testprep parameter form supports entries for multiple probe-types. Typically the names are 100, 75 and 50 MIL. The names and center to center spacing is user definable.

To add a row in the form, select a Probe Type cell then RMB – Add.

Drill Legend Support for INCHES and METRIC

Update your default .dlt file as shown below

```
?AlternateUnits "millimeters"
?ColumnDefinitions `(    
 ("Figure"   "FIGURE"   7)     
 ("Holesize" "SIZE"       15)      
 ("Tolerance" "Tolerance" 15)    
 ("Holesize2" "SIZE MM" 15)      
 ("Tolerance2" "TOLERANCE MM" 15) 
```
Uprev Symbols

The command “uprev_overwrite” can be used to uprev library files to the current software revision.

Syntax – uprev_overwrite n where n = *.dra; *.psm; *.ssm, etc

Ex – in a command window, enter uprev_overwrite *.dra to update all .dra files to the current software level.

For more flexibility in upreving in a DOS command window do a:

uprev -help

** Be sure to make a backup copy of your library before uprev
Troubleshooting – Running Allegro in Safe Mode

Many Allegro programs support the "-safe" command line option. This starts the program without any user customizations or extensions. This can be used a debug mechanism to eliminate if user configurations are the cause of the problem with the product.

It disables loading at startup
- local env file (<HOME>/pcbenv/env)
- cds_site configuration data
- any user skill code
- pre-register scripts
- ini file which stores window size/position information
- most recent used files (MRU)
- remembered Windows positions (.geo files)

UNIX: Currently it cannot disable X window resource settings.

In addition graphic programs support the "-noopengl" option which will disable the enhanced Graphics based upon OpenGL.

Example: Run an "out of the box" allegro without opengl
    allegro -safe -noopengl

Tips from Allegro PCB Users

Join the Cadence Community Website and see what other users are saying
Windows 7 – Graphic issues
Try disabling Aero (desktop composition) for allegro only:

1. Navigate to the executable or shortcut for the program you wish to disable desktop composition using Explorer.
2. Right click on it and select Properties.
3. Select the Compatibility tab and check Disable desktop composition, then click on OK.
4. As always, ensure your graphic driver is up to date.